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Copernicus is a username and password remembering program that enables you
to store all your various internet login details in one convenient location. Rest
assured, it is totally free from spyware and adware which tend to haunt this type of
program. Apart from it’s ease of use, other benefits of Copernicus include the fact
that it doesn’t cost you a cent, is open source, will work on most modern computing
platforms such as Linux, Mac OS X and Windows, and is available in more than
ten different languages.
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1. Using Copernicus

Copernicus has a streamlined graphical user interface focussing on making it fast and as easy
to operate as possible. Copernicus is primarily used to store internet usernames and passwords
and doing this is simple. The steps for an example user session are detailed below.

To record new login details for an internet site, firstly click on the Create New Site button
and enter the name of the site. This could be for example “Hotmail”. Then you can enter
your login details to the right in the username and password field. If there is extra information
that you would like associated with this login then you can enter it in the comments text box
underneath the password field.

If you have two different logins associated with the one site (using the Hotmail example
if you have two email accounts) you can create a second Account in Copernicus simply by
clicking Enter New Account and then entering the username and password as you did for the
first one.

Once you have entered some data it is probably a good idea to save the file. Do this by
pressing Ctrl+S on your keyboard or selecting File->Save from the menu.

While Copernicus is geared towards remembering username and passwords, you can also
use it to store other information for example the purchase date of your computer hardware or
perhaps software serial numbers for easy reference.

Looking up information in Copernicus is even easier than entering it. Simply pick a site
from the list displayed on the left of the window and click on it. The details for the first login
will then be displayed. To view any other logins associated with the site either select them
from the drop down box or click the “next login” shortcut button denoted by the ’>’ symbol.

If the list of sites gets very large (and it probably will) - you can filter the list by typing
some text in the text field labeled search and pressing enter. For example, if you type the
word “mail” into that text field and press the enter key - all sites with titles containing the
word “mail” (this would include our example of Hotmail) will be displayed and the others will
be hidden from view.

To display all of the sites again, simply delete all of the text from the search text field and
the list should revert back, showing all sites alphabetically.

That is essentially how you use Copernicus. There are various other operations that you
can perform such as renaming a site or login by using the menus. These operations are much
less frequently used than the ones above. Refer to the “Menu Command Glossary” section for
details on all available operations accessed though the menus.
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2. Synchronisation - Using Copernicus on Multiple Computers

There are several ways of using Copernicus on multiple computers.

2.1. Importing and Exporting

Synchronisation across multiple computers using the Import and Export tools.

When you make updates on one computer which you would like transferred to another
one, simply export your user file to a some removable device (floppy disk, CD-R, email etc).
Then on the second computer open up your current file and select File->Import. Select the
file which you exported to on the other computer and click Open. All sites that exist in the
file you are importing from but not in the file you are importing will be added. For every
site which already exists you will be prompted to overwrite the current one with the imported
one. You are able to select Yes to All to overwrite all without asking and No to All not to
overwrite any. Select No to All if you only want new sites to be merged with the current file.
If you made changes to existing sites on the first computer, then Yes to All is probably your
best choice to get all of the changes into the second computer (note: If you select Yes to All
changes you made on the second computer may be overwritten).

After an import, you will need to save the file for the changes to become permanent. If
something goes wrong in the importing process simply exit without saving.

2.2. Copying user file

To transfer your settings from one computer to another, simply copy your Copernicus user file
from one computer to the next. On the second computer, you can open the file with the Open
command.

2.3. Same file

Alternatively you can have two installations of Copernicus use the same file. For this to work
the user file would need to be stored on a medium that both computers have access to for
example a network drive or removable media such as a floppy disk or CD. Using a removable
medium has the added security advantage in that you can simply take your passwords with
you.

NOTE: Copernicus is NOT designed for two instances to access the same user file at the
same time. Read-only access would not cause any problems but each time one instance saved
the file, it would overwrite changes that the other one made and vice-versa
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3. Copernicus in a Multi-User Environment

Copernicus is designed to work well with multi-user environments such as Linux and later
versions of Windows.

When Copernicus is run for the first time by a user, the file .copernicus.ini is created
in their home directory which stores all configurable Copernicus settings (such as default
language). This means that each user has their own set of configurable options, rather than a
global set which they share.

If however you want to set it it up so that settings are global - there is a way to do it. Before
Copernicus loads the ∼/.copernicus.ini file (“∼” represents the users home directory) if first
checks to see if the file copernicus.ini exists in the current working directory (usually the
directory from which Copernicus is launched, or as specified as a shortcut property). If it does
exist then those options are used instead. Note: It may not always be possible to set this up,
for example if you are using Copernicus with Java Web Start.
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4. Advanced Options

4.1. Launching Copernicus

Windows users who use the Installation EXE file can simply click on the Copernicus icon to
launch.

If this isn’t enough, Copernicus can be launched from the command line with the statement
java -jar copernicus.jar or java -jar /path.to/copernicus.jar. With this knowledge
it is possible to setup global scripts (eg. for linux in your /bin/ directory). In windows,
assuming that the .jar file type is associated with Java (which it is by default) you can launch
the .jar just as you would a normal file with an associated program like a Word Document.

4.2. Command Line Arguments

If Copernicus is run with the argument DOUTPUT LANG=true (that argument should be before
the -jar or -cp argument) a file is created in the current working directory named “Lang-
sync.ini” which contains all of the language files, with any new strings added.

4.3. Configurable Options

Copernicus support several options which are not changable from the program. Open the file
∼/.copernicus.ini (“∼” represents the users home directory) to see some further options
(such as a custom Look & Feel).
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5. Custom Language Files

It is possible to create custom language files or redefine existing ones if the included multi-
lingual support is insufficient.

Copernicus will load any language packs (complient .ini files) from the directory ∼/.langpack/
(“∼” represents the users home directory). The .ini files can have any name and contain mul-
tiple language packs. Please open one of the included ones (if you unzip the copernicus.jar
file you will see them in the directory data/langpack/). If you copy one of the inlcuded ones
into your custom directory and make changes, then your changes will be loaded in preference.
If you create a new language pack (signified by a new langauge code, eg “[CUS]”) then you can
also specify the flag image to use by placing a file named “cus.gif” where “cus” is the three
digit code for your language pack, as used in the ini file and place it in a subdirectory named
flags within your ∼/.langpack/ directory.

5.1. Translating Instructions

The strings are listed like so:

Help={
Help
}

The first “Help” is the Native text (ie. English) and the second one is where the translation
should go. The German translation looks like this (Hilfe is German for Help):

Help={
Hilfe
}

Some notes: The strings can NOT have any line breaks. Line breaks can be achievedby
adding a “\n” to denote where the new line occurs.

Some string may look like this: “Unable to save ini file: %filename%.” The %filename%
bit is actually replaced by the real filename which has the problem at runtime, so a german
translation would look like this: “Speichern der Datei unmglich: %filename%.”. If there are
two or more of those variables, at present the order can’tbe changed (so don’t swap two of
them around).

Copernicus uses UTF-8 character encoding, all language files must be in that format. I use
and recommend the text editing program jEdit1.

1http://jedit.org/
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6. Credits

6.1. Programming

• William Denniss <will at tanksoftware dot com>

6.2. Translating

• German - Cengiz Sahin <Cengiz.Sahin at dat dot de>

• Turkish - Cengiz Sahin <Cengiz.Sahin at dat dot de>

• Chinese - Tony Liu <tonybearliu at yahoo dot com>

• Spanish - Rafael Faura <rfaura at bassy dot net>

• Catalan - Alex Guardiet <alexguardiet at yahoo dot es>

6.3. Beta Testing

• Peter Denniss

• Rhys Parry

6.4. Third Party Libraries

• The Kunststoff Look&Feel http://www.incors.org/

• jtank library http://jtank.net/
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A. Menu Command Glossary

A.1. File Menu

A.1.1. Recent User

Allows one to easily load another user of Copernicus. All past users of Copernicus are listed
here unless they are removed by the Edit->User->Delete command.

A.1.2. New

Creates a new Copernicus user in memory. Note: You must save this user at least once before
it will be added to the list of Recent Users and written to disk.

A.1.3. Open

Opens an existing user file into Copernicus and adds it to the list of Recent users. Note: You
should only do this when importing a user into Copernicus - normal use is to select the user
from the Recent User list instead.

A.1.4. Import

Imports all of the sites from the given user file. Confirmation will be requested before over-
writing existing sites.

A.1.5. Export

Saves a copy of this user file. The newly created file is NOT added to the list of recent users
nor is used for future exiting. Regardless of the current user’s encryption selection, the option
to encrypt the exported file with a different password to the one specified will be given. To
protect safety of the current user, the current user password (if set) must be entered to proceed.

A.1.6. Save

Saves the current user to disk. If this user is a new user then a Save As dialog box will be
presented requesting a filename to use.
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A.1.7. Save As

Duplicates the current user in a new file and adds the duplicate to the Recent User list. Further
changes made in this session will effect the NEW user file.

A.1.8. Close

Closes the current user file. If the current file is unsaved the user will be prompted to save.

A.1.9. Exit

Exits Copernicus. If the current file is unsaved the user will be prompted to save.

A.2. Edit

Operations to organise the current user, site and login.

A.2.1. User

Operations which can be performed on the current User

Change Display Name Changes the display name of this user. The display name is shown
in the title bar of the Copernicus window and in the Recent Users list in the File menu.

Set as default Instructs Copernicus to always load up this user when starting

Use Encryption When encryption is being used, every time Copernicus loads the user file, it
will prompt for a password to encrypt/decrypt the file. Certain actions also require confirma-
tion of the password (such as exporting the passwords to an new file).

It is very important to note that should you forget the password used to encrypt your
Copernicus user file then unless you are able to break encryption your DATA WILL BE LOST!
There is NO way to recover lost passwords as it is never stored in plain text.

The default encryption plugin is a weak grade encryption designed to hide your passwords
from a casual curious user of your computer. It would not stand up to a brute force attack by
a cracker. Copernicus supports third party plugins so it would be possible to encrypt the file
using very strong encryption such as PGP.
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If you wish to hide your passwords but don’t want to use the encryption, one option is to
discuise your passwords in plain site. Substitute your password for a common word to represent
it eg. (main-pass). If on one site you need to append a ’1’ to it, then that can be stored as
(main-pass)1.

Change Password Change the current password. First the old password must be entered,
then the new one and confirmation. NOTE: You will need to save the file for the file to actually
be encrypted using the new password.

Delete Removes the current user from Copernicus’s Recent Users list. NOTE: This does not
physically delete the user data. To do this you need to remove the *.wxml file that is associated
with the user you wish to remove.

A.2.2. Site

Operations which can be performed on the current Site

Enter New Site Creates a new site and the default login

Rename Renames the title of the current site.

Delete Removes this site and all logins associated with it. Like all changes, this can only be
undone by not saving the user file.

A.2.3. Login

Operations which can be performed on the current Login

Enter New Account Creates a new account for the current site which can store such infor-
mation as Username, password and comment.

Rename Renames the title of the current login. The title is for display purposes only.

Delete Removes this login - note: this operation can only be performed when there are
multiple logins for the one site. One can delete an entire site by the Edit->Site->Delete
option.
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A.3. Options

User customisable options.

A.3.1. Hide Languages

Hides the “Language” menu item

A.3.2. Use System Look and Feel

Renders the Copernicus UI using your computers default Look and Feel. In windows, this will
make Copernicus look more like a windows application.

A.4. Language

Displays a list of all localised version of Copernicus with their flag and three digit country code.
If a different language is selected then the GUI automatically switches to that new language.
Next time Copernicus is loaded then that language will automatically be selected.

A.5. Help

A.5.1. Help

Opens this help in your browser

A.5.2. About

Displays Copernicus version numbers and authors
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B. Configuring Unicode Fonts with Java

One of Java’s many strengths is that it has in built Unicode support. All Copernicus files (user,
settings and language packs) are encoded in the Unicode UTF-8 format. Subsiquentally one
can use Copernicus with several different character sets (even at the same time). For example,
Copernicus has a Chinese user interface translation.

Setting Java up to use a unicode font is currently a little tricky. Please continue with these
instructions if you know how to unzip files, install fonts and edit configuration text files.

B.1. Downloading a Unicode Font

There are several free unicode fonts on the Internet. The one that I use and recommend is one
named Bitstream Cyberbit. It covers a huge range of characters including Greek, Chinese and
Japanese.

As of writing, you can download this font free of charge from:
ftp://ftp.netscape.com/pub/communicator/extras/fonts/windows/Cyberbit.ZIP If it is no longer
available, please search for “Bitstream Cyberbit”

B.2. Linux

Linux users, please follow these steps to setup Java with the Bitstream Cyberbit TTF font.
Note the jre is the directory where your Java Runtime Environment is installed (if you have
the full SDK, this will be in the jre directory in that).

1. Copy Cyberbit.ttf into your /jre/lib/fonts/ directory.

2. In that directory, edit the file fonts.dir.

3. Increment the number at the very top of the file (eg. change “72” to “73”)

4. At the bottom, add a new line:
Cyberbit.ttf -b&h-cyberbit-bold-i-normal-sans-0-0-0-0-m-0-iso8859-9

5. Edit the file /jre/lib/font.properties.

6. To the “serif” group, add a new line such as this:
serif.2=-b&h-cyberbit-bold-i-normal-sans-0-0-0-0-m-0-iso8859-9 Where the 2,
is the next available number.

7. Repeat the above step for at least each major group (i.e. monospaced, dialog, dialoginput,
etc). Copernicus mainly uses “dialog” so don’t miss out that one!

14

ftp://ftp.netscape.com/pub/communicator/extras/fonts/windows/Cyberbit.ZIP


Copernicus User Manual

8. close all running Java programs

9. load the Java programs and they should have unicode font support

B.3. Windows

Windows users, please follow these steps to setup Java with the Bitstream Cyberbit TTF font.
Note the jre is the directory where your Java Runtime Environment is installed (if you have
the full SDK, this will be in the jre directory in that).

1. Copy Cyberbit.ttf into your $Windows
Fonts directory.

2. Edit the file /jre/lib/font.properties in Wordpad, jEdit or another text editor (NOT
Notepad!).

3. To the “dialog” group, add a new line such as this: dialog.3=Bitstream Cyberbit,DEFAULT CHARSET
Where the 3, is the next available number.

4. Repeat the above step for at least each major group (i.e. monospaced, serif, dialoginput,
etc). Copernicus mainly uses “dialog” so don’t miss out that one!

5. Now scroll to the “# Font File Names” section near the bottom of the file.

6. add an entry for Cyberbit - filename.Bitstream Cyberbit=Cyberbit.ttf

7. save and close file

8. close all running Java programs

9. load the Java programs and they should have unicode font support
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C. Creating Encryption Plugins

Software Engineers with knowledge of Java and encryption technologies can write their own
custom encryption plugins which work with Copernicus and can be distributed as third-party
products designed to work along side Copernicus.

Copernicus supports third party cryptograhy plugins. The one that is shipped with Coper-
nicus is a weak encryption designed mainly to obscure the text fending off casual users rather
than hard core hackers. However it is quite easy to create your own plugin without modifying
the Copernicus source (meaning other users can use it too).

Encrypted user files in Copernicus have the following format:

Copernicus Encrypted User File #title
com.tanksoftware.juk.DefaultEncryption #plugin
1.23 #version
ab93b2fg9370a2b28c9f9d9b9g98a #password double md5 hash
[reserved] #reserved for future use
[reserved] #reserved for future use
-----BEGIN ENCRYPTED-----
#Encrypted Contents
#Encrypted Contents
#Encrypted Contents
#Encrypted Contents
#Encrypted Contents
#Encrypted Contents

Full example:

<dpass username="New User 1 (copy)" encrypted="true" >
<site >
<name>Example1</name>
<login userid="My Primary Account" username="user1" pass="xyz" >
<comment>Main Account</comment>
</login>
<login userid="My Secondary Account" username="user2" pass="xyz" >
<comment>Secondary Account</comment>
</login>
</site>
<site >
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<name>Example2</name>
<login userid="My Primary Account" username="user1" pass="xyz" >
<comment>Main Account</comment>
</login>
<login userid="My Secondary Account" username="user2" pass="xyz" >
<comment>Secondary Account</comment>
</login>
</site>
</dpass>

becomes (when encrypted with the NOCPLugin and the password “asdf”)

Copernicus Encrypted User File
com.tanksoftware.juk.NOCPlugin
1.0
0e3d127a92a3b4069b1d0d9b101c9bd0
[reserved]
[reserved]
-----BEGIN ENCRYPTED-----
~o<qi4Y0Y&p4y&u=Hu4UBJ&’<q;’yD.<^<V,vU7"hj[Z)UC5PJ^C@~
4+_(=cg
WB<FfhG;w"d!{vYANny/a
V*x\Z^(o57V\[2Ke_rY,.1YEj.yAn;T5J1V49^2PX_SLoRkH_QZm ?ejQAx~wh$z
!l:QFpZ!@6b5c]Ao_*sYtCFy9ZY8{b]
,hcVh:\L
}voVu/(#1grB[0<yHH@_ntX8g?Bja$hw@h@&.yk>>w;-FLr!2@jgCXBu"p#P\GVvv-
B6X}\ta7-M^5ofjY]-S9DlE35;O~W5U4ncL9
tsyPvCGU
P13ix!R
]d=dE=Q
QWQS$b@|aiVT{bSQsKTX-
m|-OU_l8Y]T,t<F\LsLiBT+mvC’Z,JVUQjg%sGv@To1{b>fu?#1R.|s@"5^ik:!a
N[%V>dGOLEFB+%sP]Dp~ YrHNMtd_gc
LoQ+YKlL
M&3w.B|ru*T?l_|(J!Jqh&}^>0#n\k*:U<:]huT\/$k2c@f=mO,;g9uO]r{.9"] lJ
WJ=a(X|_?]NW)=^zng"#V-PA(|7B\xN1u[Ny
V!$)_s[I
R<aK@BD
@U:i>tNj
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When Copernicus reads a user file, any file beginning with “Copernicus Encrypted User
File” will always be passed though the decryption mechanism before parsing with the XML
parser.

All of the data above the BEGIN ENCRYPTED text is read by Copernicus. It tells it
what plugin was used, version and the password double hash of the user.

The plugin then returns the decrypted data for parsing.

Once the user enters the right password, the password and the text is passed into the
plugin. The actual encryption can happen in any way. The password can be used as a key for
example or maybe to unlock a private certificate.

C.1. Changing default encryption plugin

The user can specify which encryption plugin to use by default in the copernicus.ini file, a
sample which is below:

[MAIN_SETTINGS]
...
CryptographicPlugin=com.tanksoftware.juk.NOCPlugin
...

com.tanksoftware.juk.NOCPlugin is the class name of the plugin, and that class MUST
be in the users class path (ie. contained in the copernicus.jar file or in the users jre/lib/ext/
directory.).

The plugin specified in the settings ini is used every time encryption occurs. When files
are loaded and decrypted however, the plugin used to encrypt them (if available) will be used
instead. There is no supported way to change this behaviour. People upgrading plugins or
changing to a different one benefit from this as they just have to set that option, then load
and save all of their files.

The NOCPlugin is the shipped with Copernicus and is the default.

C.2. Coding a plugin

Creating an encryption plugin if you are knowledgable about Java and Cryptology is not a
difficult task. Plugins must implement the interface CryptoPlugin and it’s three methods

String encrypt (String password, String toEncrypt) throws CryptoException
String decrypt (String password, String toDecrypt) throws CryptoException
String getVersion ()
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The encrypt and decrypt methods accept a password and text. Using the password as a key
(either directally or as a password to unlock a private key for example) they encrypt/decrypt
the text and return the result. The most basic plugin would simply have the statement return
toEncrypt; which would not perform any encryption but is a valid plugin.

If an error occures that the user needs to be informed about then a CryptoException can
be thrown. This will cause the loading of the user file to fail, and present the user with the
reason (using the getMessage() method of the CryptoException.

The getVersion() method plays a significent role in the plugin behaviour.

Before the plugin is used, the version is checked against the stored version in the user file. If
the version numbers don’t match a warning is given to the user that it may not work. Ideally,
encryptions plugins should be backward compatable. The version number is not arbitrary. It
is in the format <int>.<int> where the first int is the “major” version number, and the second
is the “minor” version number.

A plugin MUST be able to interpret all files encrypted with ALL past plugins with the
same major version number (ie. for an example plugin XPlugin, XPlugin 1.2 should be able to
read files made with XPlugin 1.1 and 1.0). A plugin MAY interpret files encrypted with past
plugins with differing version numbers. A warning message is displayed to the user stating
that the decryption operation may not work if either the major version numbers don’t match,
or the encryption plugin used to decrypt has a minor version number less than that which was
used to encrypt it.

Due to this, it is advised not to change the major version number and not to make backward
incompatible changes. If significant changes need to be made, then creating a new plugin with a
different name is recommended so that they can both be installed at once. Forward-compatible
plugins (eg. where an earlier version of a plugin can decrypt the output of a later plugin) are
not explicitly supported, if this is the case then it may not be necessary to change the version
numbers at all.

C.3. Distributing a plugin

To get the plugin installed on the users system, you need to place your class files in the users
class path (see above section “Changing default encryption plugin”). If you want the users to
use the plugin for encrypting as well as decrypting, you need to provide instructions on how
to edit their copernicus.ini file (or do it for them).
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D. Hacking Copernicus

Copernicus is an Open Source, GPL2 licensed . Java Programmers are able to make changes
and distribute those changes provided they are also open source and licensed under the GPL.

You need the Java SDK3 installed to compile, and Apache Ant4 to use the build file
(strongly recommended).

Ensure you have the .tar.gz release (not the Windows Install) and decompress it to a
directory.

To compile, simply type ant. If LaTeX is installed and on your system (as it is with many
Linux distros), you can run ant pdf and ant html to create the documentation PDF and
HTML respectively. To release a build, run and rel. To make the Windows installer, run the
Copernicus.nsi script though the NSIS5 installation builder.

2GNU General Public License http://www.gnu.org/copyleft/gpl.html
3http://java.sun.com/
4http://ant.apache.org/
5http://nsis.sourceforge.net/
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